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1 Introduction

ProFiDo (Processes Fitting Toolkit Dortmund) is a flexible environment written in Java
for realising different steps of input modeling. ProFiDo offers a GUI to combine var-
ious command line tools realising steps of data preprocessing, parameter fitting and
analysing the resulting processes into a workflow. In the current version (effective
August 2014), ProFiDo supports fitting of common distributions, Phase-type (PH) dis-
tributions, Markovian Arrival Processes (MAPs), Correlated Acyclic Phase-Type Pro-
cesses (CAPPs), AutoRegressive To Anything (ARTA) processes and AutoRegressive
Integrated Moving Average (ARIMA) models from trace data and the analysis of these
distributions and processes. The theoretical background on these stochastic processes
is out of scope of this manual. Readers not familiar with these processes are referred
to [16, 17] for PH distributions and MAPs, to [15] for CAPP processes, to [10] for
ARTA processes and to [7] for ARIMA models.

For a general overview of ProFiDo’s key features and the motivation that led to the
development of ProFiDo the reader is referred to [1, 4]. Technical documentation on
the different file formats that ProFiDo uses for its configuration, for saving workflows
and for the description of stochastic processes can be found in [2, 3, 6].

This document is structured as follows. Installation instructions for ProFiDo are
given in Sect. 2. Sect. 3 contains an introductory tutorial and Sect. 4 explains the use
of ProFiDo in detail.

2 Installation

The latest version of ProFiDo can be obtained as a zip archive from

http://ls4-www.cs.tu-dortmund.de/profido

The archive contains the GUI ProFiDo and a collection of tools for fitting stochas-
tic processes and result visualisation. The GUI is released under the GPL (see Sect. 2.1)
and the sources are available on the website as well. The included tools are currently
only available as binaries.

2.1 License

ProFiDo is free software, released under the terms of the GNU General Public Li-
cense version 2 as published by the Free Software Foundation. ProFiDo is distributed
in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU General Public License for more details.

2.2 System Requirements

ProFiDo is available for Linux and Windows. Depending on the operating system
different requirements have to be fulfilled to run ProFiDo.
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2.2.1 Linux

To run ProFiDo’s GUI only Java is required. However, for full functionality including
all the supported tools for fitting and result visualisation the following system require-
ments have to be fulfilled:

• Linux

• Java

• wish - Tcl/Tk shell required for converter scripts

• gnuplot - required for creating plots of autocorrelation, cdf and pdf

• R - required for ARIMA fitting and statistical tests [23]

2.2.2 Windows

The Windows version of ProFiDo is bundled with a MSYS1 environment that contains
most of the tools required by ProFiDo. For the Windows version only Java is needed.

2.3 Installing ProFiDo

2.3.1 Linux

1. Extract profido1.3.zip to a local directory (the recommended directory is
~/ProFiDo):

mkdir ~/ProFiDo
unzip profido1.3.zip -d ~/ProFiDo

The directory should now contain four files (profido.jar, software.xml,
profido.sh, gpl-2.0.txt) and a subdirectory (software).

2. If you did not use ~/ProFiDo as installation directory you have to edit the file
software.xml and replace ${HOME}/ProFiDo in line

<softwaresource>${HOME}/ProFiDo/software</softwaresource>

at the beginning of the file with your installation directory.

3. Change to your installation directory and run ./profido.sh to start ProFiDo’s
GUI.

2.3.2 Windows

1. Right click profido1.3_win.zip and select "Extract..." from the files con-
text menu and choose a target folder (the recommended directory is C:\). Note
that the identifier of the selected target folder must not contain a blank or other
white space characters!

1http://www.mingw.org/wiki/msys/
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Afterwards the selected directory will hold a subfolder called MinGW which
contains the preconfigured MinGW/MSYS environment and the entire ProFiDo
software.

2. Open the subfolder MinGW/msys/1.0 within the target directory and execute
msys.bat to start a MSYS shell. Within this MSYS shell type cd profido
to change to the ProFiDo directory and run ./profido.sh to start ProFiDo’s
GUI.
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3 Quick Start Guide

The following sections explain step-by-step how ProFiDo’s GUI can be used to build
up an example workflow description and how this workflow can be executed. This
quick-start guide will only explain the basic functionality that is necessary to specify
the example workflow and gives a first overview of the features of ProFiDo. A detailed
description of ProFiDo that introduces all the features and properties will be given in
Sect. 4.

3.1 Specification of an Example Workflow

In the following we will assume that the user wants to create a simple workflow to
fit MAPs to a given trace file using two different fitting approaches. To assess the
quality of the fitted MAPs some characteristics of the MAPs and the trace file should
be visualised.

1. Starting ProFiDo by calling profido.sh gives a window with an empty can-
vas as shown in Fig. 1.

Figure 1: Empty Workflow

2. Describing a workflow means essentially to describe a graph with edges and
nodes. So let us start with the first node of the graph describing an input file.
Input files are usually trace files that contain observations from a real system
and that we want to fit with a stochastic process. For selecting an input file click
on Workflow in the menu bar and select Add Input File (see Fig. 2).
This will open a dialog window, where one can select the input file (see Fig. 3).
After that the node which is associated with the input file is placed with a click
into the canvas window (see Fig. 4). For our example workflow we opened the
trace LBL-TCP-3 [22] from the Internet Traffic Archive [25] that was reduced
to contain only the interarrival times. This version of the trace is also available
from ProFiDo’s website (see Sect. 2).
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Figure 2: Adding an input file node

Figure 3: Selecting the input filename
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Figure 4: Positioning the input node

3. In a similar manner other nodes can be placed on the canvas. E.g. to insert the
call of a fitting tool into the workflow click on Workflow in the menu bar and
select the specific type of job using Add Job (see Fig. 5). After positioning the
node a window will pop up where job specific parameters can be specified (see
Fig. 6).

For the example workflow two MAP fitting algorithms are added to the work-
flow, in particular a tool called ACfit that fits a MAP according to the lag-k
autocorrelations of the trace and a tool called JMomfit that uses the empirical
joint moments for fitting. Since both tools expect a PH distribution as input, we
place the tool Momfit that fits a PH distribution according to the moments of a
trace on the canvas.

Since we want to assess the quality of the fitting algorithms we add the tools
Plot and Print to the workflow. Plot can create figures showing differ-
ent properties of the models like autocorrelations or the distribution function.
Print has a similar function for statistical properties that should be output in
textual format and can for example generate a LATEX table.

Fig. 7 shows the canvas with all tools added so far. Note, that the tool specific
parameters that are entered in the property window from Fig. 6 are displayed
above the different job nodes. Thus, Momfit will use the first 9 empirical
moments from the trace to fit a PH distribution with 3 states and run for 20000
iterations. JMomfit will consider the first 5 × 5 joint moments and ACfit
the first 10 lags of autocorrelation. Plot will create a PostScript (PS) image
plotting the first 10 lags of autocorrelation and Print will create a LATEX table
with the first 5 joint moments. A detailed description of the different tools and
their parameters will be given in Sect. 4.

4. To define the outputs of the workflow, one can specify output nodes. Defining
an output file is similar to specifying an input file. Select Add Output File
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Figure 5: Inserting a job node

Figure 6: Example of a parameter window of a job node
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Figure 7: Canvas with several job nodes

in the menu bar (see Fig. 8) and choose the directory where the output file shall
be stored and specify its name. Afterwards a window pops up where you can
select the type of output (see Fig. 9). Finally the node representing the output
file is positioned on the canvas (see Fig. 10). For our example we place two
output nodes on the canvas, one for a PostScript file (lbl_ac.ps) and one for
a LATEX file (lbl_jmom.tex).

Figure 8: Adding an output file

5. To complete the workflow description nodes have to be connected by edges.
In order to connect two nodes by a direct arc first click on the source node
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Figure 9: Selecting the type of output

Figure 10: Positioning the output node
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such that the node is highlighted. Afterwards right-click on the destination node
and select the first option Connect output from selected node to
this (see Fig. 11) which results in a directed arc connecting source and desti-
nation node (see Fig. 12).

In a similar way all other arcs can be created completing the workflow specifi-
cation (see Fig. 13).

Of course, arcs may be created at any time during the workflow specification,
not only after all the nodes have been placed.

Each arc contains a label with the model type for the model description that is
propagated between the two nodes. Additionally, a file name is associated with
each connection. ProFiDo will automatically determine an unique file name for
each arc such that no conflicts occur. However, in some cases it is desirable to
manually chose a file name. For example the tools Plot and Print use the
file names as labels for the curves of the plot or for the columns of the table.
Observe from Fig. 13 that we changed the file names at the arcs from JMomfit
and ACfit to Plot and Print to MAP3_JM.xml and MAP3_AC.xml. The
file name can be changed by selecting Edit Connection from the context
menu of the arc.

Figure 11: Connecting with destination node

3.2 Executing the Workflow

Once the workflow specification is complete, the entire workflow can be exported to
a shell script and be executed. Select Export Workflow as Script from the
Workflow menu and choose a file name to export the workflow. ProFiDo will create
two shell scripts (<name>_setup.sh and <name>.sh) that setup all the necessary
tools and execute the tools of the workflow. ProFiDo automatically sorts the order of
execution of the different tools corresponding to the job nodes according to their order
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Figure 12: Result after connecting two nodes

in the workflow. Call <name>_setup.sh to setup the tools for the workflow. After
that the workflow can be executed by calling <name>.sh.

In addition to the export of the normal workflow an extended workflow with ad-
ditional report can be created. Select Export Workflow as Script with
Report and choose a file name accordingly. ProFiDo will export the above described
workflow scripts and two additional files (<name>_report.sh and <name>_report.tex)
located in directory Results/Report. The <name>_report.sh script will be
called after the execution of the workflow and creates a versatile PDF report file con-
taining all properties of the workflow and its intermediate as well as final results.
The PDF report file is generated from LATEX files generated by ProFiDo, which can
be used as a basis for further documentation. The LATEX files are located in directory
Results/Report/Files.

Table 1: Joint moments for the workflow from Fig. 13

Joint Moment lbl3_dat MAP3_JM MAP3_AC
1, 1 1.30 1.29 1.30
2, 2 17.42 17.65 15.97
3, 3 890.5 890.5 673.9
4, 4 107474 105484 70378
5, 5 21417760 22268852 14002609

The execution of the example workflow will result in two files as specified by the
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Figure 13: Example of a complete workflow
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Figure 14: Plot of autocorrelations for the workflow of Fig. 13

output nodes in Fig. 13. The plot with the autocorrelations is shown in Fig. 14. Table 1
shows the joint moments created by the Print node. Observe, that the curves in
Fig. 14 and the columns in Table 1 are labeled with MAP3_AC and MAP3_JM which
corresponds to the file names we entered at the incoming arcs of Plot and Print in
Fig. 13.

Once the workflow has been executed, the Edge View functionality can be used
to display intermediate results. In order to do this right-click on the edge and select
the option Plot Details (see Fig. 15). The menu item Plot Details opens a
window similar to the parameters window of the job node Plot (see Fig. 16). After
confirming the values with a click on the OK button the characteristics of the selected
model are displayed in a new window. In addition to the graphical view a text based
display of intermediate results is also possible. To display textual informations select
the option Print Details (see Figs. 15 and 17).
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Figure 15: Plotter functionality

Figure 16: Property window of the Edge View Plot
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Figure 17: Property window of the Edge View Print

4 Working with ProFiDo

In the following we will explain in detail how ProFiDo can be used for fitting stochastic
processes. In Sect. 4.2 the workflow specification and execution is presented. Sect. 4.3
gives a detailed overview on ProFiDo’s menu structure and the functions available
from the menu bars. Finally, in Sect. 4.4 we give some background on the tools that
are currently integrated into ProFiDo and introduce their parameters.

4.1 Commandline Parameters

ProFiDo can be called with various commandline parameters to load an existing work-
flow or to perform automated tests. Most of the commandline parameters are used to
control the integrated Test Manager which is explained in Appendix A in detail. If no
parameters are given ProFiDo will start with an empty canvas.

ProFiDo can be called by
profido.sh [OPTIONS] [INPUT-FILE] [EXPORT-FILE]
where all parameters are optional. [INPUT-FILE] specifies a workflow to be loaded,
[EXPORT-FILE] a file name to store the workflow. [OPTIONS] may be any of the
following:

• -c <file>: Selects a custom configuration file. (Default: software.xml)

• -n: Disables all file existence checks when loading a workflow.

• -nv: Disables the XML validation.

• -h, --help: Displays usage information.
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• -t <mode> <interactions>: Activates the TestManager in the selected
mode and performs the specified amount of user interactions. (Default: No mode
selected, interactions = 10)

• -d <delay>: Specifies a custom time in milliseconds between two user inter-
actions within the TestManager. (Default: 5)

• -s <seed>: Specifies a custom seed for the TestManager. (Default: Time
since midnight, January 1, 1970 UTC in milliseconds.)

4.2 Workflow Specification and Execution

In ProFiDo the fitting of stochastic processes is described by workflows. Workflows
are composed of different nodes that represent different steps of data preprocessing,
fitting and result visualisation. Each node of the workflow corresponds to a tool that
is responsible for performing one of these steps. The nodes are connected by arcs
to determine the order of execution of the tools and the result propagation from one
tool to the next. In this way it is possible to specify complex workflows consisting of
various connected tools in a graphical manner.

4.2.1 General Outline

A workflow is represented by a graph composed of a minimum of the following nodes:

• At least one input node associated with an input file, which usually is a trace file
or a stochastic process in ProFiDo’s XML interchange format [6].
The first entry of a trace file is the number of subsequent elements in that file.
All other entries are interpreted as data values, e.g. inter-arrival times, packet
sizes etc.

• One or several job nodes each representing a particular tool. Detailed descrip-
tions of the tools will be given in Sect. 4.4.

• One or several output nodes associated with an output file. Possible outputs
are traces, stochastic processes in different formats (like ProFiDo’s XML in-
terchange format or Nsolve’s [18] format for MAP descriptions) and image or
LATEX files for various plots and tables with characteristics of stochastic pro-
cesses and traces.

An example of a workflow is shown in Fig. 13.

4.2.2 Building a Workflow

Specification of a workflow can be done by placing nodes on the grid and connecting
them with directed arcs. The connection has to observe certain rules.

18



Placing nodes on the grid ProFiDo distinguishes three types of nodes: Input nodes,
job nodes and output nodes.

• Input nodes are the first nodes of a workflow and have no predecessor. Input
nodes are used to specify files that are used as input for the workflow. In most
cases the input nodes will be used to load a trace file.
To add an input node, select Add Input File from the Workflow menu.
Afterwards a file selection window will pop up where you can select the input
file. In the next dialog window the type of the file has to be chosen. After
that, one can place the input node on the grid by clicking on the corresponding
position in the canvas.

• Job nodes are the basic building blocks of a workflow that perform the actual fit-
ting tasks. Each job node corresponds to one of the tools presented in Sect. 4.4.
To place a job node on the grid, select one of the tools from Workflow ->
Add Job. After positioning the job node by clicking on the grid a window
with tool specific parameters is shown. Each job is defined by a set of param-
eters and the number of parameters might vary dependent on the job type. The
meaning of the parameters is also explained in Sect. 4.4. The user can edit pa-
rameters by changing the default values. Each parameter has two check boxes,
where the user can select whether the parameter will be enabled and/or be vis-
ible on the grid. Only enabled parameters will later be relevant when calling
the corresponding tool. A summary with all parameters whose visibility flag is
set to true is displayed above the job node on the canvas. Additionally, all pa-
rameters are displayed in a tooltip when the mouse pointer is over the job node.
Furthermore an optional description of a parameter is displayed when the user
clicks on the associated question mark ? (cf. Fig. 28).

• Output nodes are the counterpart of input nodes and mark the end of a work-
flow. Thus, defining output nodes is similar to the definition of input nodes.
Select Workflow -> Add Output File and specify name and location
within the shown file selection window. Afterwards you will be asked to select
the output type of the file. After that the output node can be placed on the grid.
Output nodes are used to specify the results of a workflow that the user is inter-
ested in. For example they might be used to save the fitted models or some plots
with characteristics of the models.

Connecting nodes To complete a workflow description the nodes of the workflow
have to be connected by directed arcs. These arcs determine the order of execution
of the different jobs and the propagation of intermediate results, e.g. if two nodes are
connected, the output of the first node will be used as input for the second node.
The connection of two nodes by a directed arc is done as follows. First select the
source node, then right click on the target node. A pop-up menu will appear which
allows different operations. Select Connect output from selected node
to this to connect the two nodes. Note, that two nodes can only be connected,
if the output of the first node is an allowed input for the second node. In particular,
input nodes have no predecessor and output nodes no successor. Input nodes may be
connected with job nodes, if the job node can process the input file and job nodes
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may always be connected with an output node. Connections between job nodes are
allowed, if the output of the first job matches an expected input of the second job.
Sect. 4.4 contains all the expected inputs and outputs of job nodes.
Usually, an arc is a straight line from one node to another. In some cases this might
not result in the best layout for the workflow, e.g. if the arc crosses other arcs or
nodes. Therefore, each arc comprises one or more (green) points which can be freely
positioned on the canvas to give a more readable graph layout (see Fig. 18). Additional
points may be added by right-clicking on one of the existing points. By default, all
points are automatically positioned by ProFiDo. To position points freely on the canvas
the option Auto Position has to be disabled.

The parameters of a connection are the file type and file name associated with the
output of a node and the order key. The file type is displayed if the option Display
Edge Information is enabled in the Settings Menu. All parameters are also
displayed as a tooltip if the cursor hovers over the corresponding point. The order key
can be used to establish the order of incoming arcs on a node. If a node can process
several incoming file parameters with the same type a lower order key is used first
when the shell script for workflow execution is built. Clicking on an existing point
allows for editing the three parameters of a connection between two nodes, which are
the file name and the file type that are used for storing the output of a node when
executing the workflow and the order key. By default ProFiDo determines file names
such that no conflicts will occur and the user does not have to care about the file names.
However, some job nodes (currently Plot and Print) use the file names as labels in
their output figures and tables. See Fig. 13 in Sect. 3 for an example.

Figure 18: Complete workflow after positioning points

An additional menu item (see Fig. 19) is offered to display characteristics of mod-
els (eg. CDF, ACF) directly. With the help of the Plot Details and Print
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Details menu items it is possible to display intermediate results.

Figure 19: Plotter functionality

It should be noted that the script (cf. Sect. 4.2.3) must have been exported and
executed once before to use the Plot Details and Print Details functional-
ity. A detailed description of the tools Plot and Print will be given in Sect. 4.4.
Clicking on the menu item Plot Details a window similar to the property win-
dow of the job node Plot will pop up (see Fig. 20). The behaviour of the item Print
Details is analogous (see Fig. 21).

With a click on the OK button the Plot / Print is executed with the edge file as
input and the characteristics of the selected model are displayed in a new window. To
ensure that everything works as described, the workflow must be saved after exporting.
Otherwise you will be prompted to specify the path of the exported script.

Figure 20: Property window of the Edge View Plot

4.2.3 Executing a Workflow

If the workflow description is complete, it can be exported to a bash script by selecting
Export Workflow as Script from the Workflow menu. Before the script is
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Figure 21: Property window of the Edge View Print

generated ProFiDo checks the workflow for consistency. A correct workflow has to
fulfill the following conditions:

- A workflow has to be acyclic.

- A workflow must start with at least one input node and terminate with at least
one output node.

- Each input node must have at least one outgoing edge.

- Each output node mut have exactly one incoming edge.

- Each job node must have at least one incoming and one outgoing edge.

If these conditions are met a file dialog pops up where the user has to enter a file-
name. After entering a filename ProFiDo will generate two shell scripts: <name>.sh
and <name>_setup.sh . The execution of <name>_setup.sh will prepare the
workspace, i.e. setting up all the tools used in the workflow. After that <name>.sh
can be called to execute the actual workflow. <name>.sh contains all the calls to
the tools corresponding to the job nodes of the workflow. ProFiDo will automatically
determine the right order of the calls from the workflow layout. After the execution is
complete, the output files can be found in the location specified by the output nodes of
the workflow. Interim results can be found in directory Results. The file names in
this directory conform to the parameters of the node connections.

In addition to the normal export an extended workflow with additional report can
be created. After selecting Export Workflow as Script with Report ProFiDo
will export the above described workflow scripts and two additional files (<name>_report.sh
and <name>_report.tex). The <name>_report.sh script will be called af-
ter the execution of the Workflow and create a versatile PDF report file containing
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all properties of the workflow and its intermediate as well as final results. All files
referenced and used by the report are in directory Results/Report. Note that re-
port files <name>_report.sh and <name>_report.tex are directly generated
from ProFiDo’s GUI and are not generated by setup scripts.

Note, that the Results and the Report directories are not automatically deleted
by the generated scripts. It is in the user’s responsibility to save files that are still
needed from the folders and to delete them between the execution of different work-
flows to avoid confusion with old existing files.

4.3 ProFiDo’s Menu Structure

ProFiDo’s GUI offers five menu entries. These are

• File Menu,

• Workflow Menu,

• Edit Menu,

• Settings Menu and

• Help Menu

and will be described in the following. Additional functionality is available via various
context menus described at the end of this section.

4.3.1 The File Menu

The File Menu offers basic functionality for loading and saving workflows. The
menu is shown in Fig. 22.

Figure 22: File Menu

• New Workflow offers the possibility to create a new workflow.

• Load Workflow allows to load a workflow description from a file in XML
format as specified in [3].

• Save Workflow allows to save a workflow in a file using the XML Format
as specified in [3].

• Quit quits ProFiDo.
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All File Menu options include a check for unsaved changes to the current work-
flow. A confirmation dialog will pop up remembering to save the current workflow, if
necessary.

4.3.2 The Workflow Menu

This menu contains all the ingredients for specifying a workflow (see Fig. 23). It offers
the following functions:

Figure 23: Workflow Menu

• Add Job offers the possibility to add a new job node into a workflow. For se-
lection one of the available fitting tools supported by ProFiDo have to be chosen.
The tools currently supported by ProFiDo are presented in detail in Sect. 4.4.

• Add Output File. This item allows to insert an output node to the work-
flow.

• Add Input File. This item allows for the insertion of an input node.

• Change Workflow Name allows to change the name of the current work-
flow.

• Set Working Directory. The working folder/directory can be set by
clicking on this menu entry. The working folder is that folder/directory which
will be suggested by ProFiDo for storing output files or from where to import
input files.

• Export Workflow as Script. This item allows to export a bash script
which governs the execution of the specified workflow.

• Export Workflow as Script with Report. This item exports the
standard workflow script and all files needed to create the automatic report.
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• Save Screenshot. This item allows to save a screenshot of the current
canvas content in Portable Network Graphics (PNG) format.

4.3.3 The Edit Menu

Figure 24: Edit Menu

The Edit Menu (cf. Fig. 24) offers basic undo/redo functionality, in particular:

• Undo the last performed action,

• Redo the last cancelled action,

• show all previously performed actions via the Show History item and

• delete the complete history.

Show History displays a list of all previously performed actions with the last
action being on bottom of the list. By selecting one of the previous actions one can
undo all later actions by selecting Move to selected state. It is also possible
to redo the changes by selecting a later action afterwards. The button Create Snapshot
saves the currently visible state of the workflow to an XML file in the ProFiDo direc-
tory.

4.3.4 The Settings Menu

This menu (cf. Fig. 25) allows for the definition of preferences, which influence the
GUI’s look and feel.

Figure 25: Settings Menu

• The Scale on resize checkbox determines whether the graph of the work-
flow will be resized when the window is resized or whether it will maintain its
original size.
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• Display Grid determines whether a grid will be shown or not.

• Display Edge Information determines whether any information are dis-
played on the central point of the edge.

• Display Node Information determines whether the visible parameters
of a job node are displayed.

• Via the entries of the Debug menu one can override some of the above set-
tings, i.e. some of the information on edges or nodes are always displayed if the
corresponding item from the menu is selected.

4.3.5 The Help Menu

The Help Menu (cf. Fig. 26) just gives more information about the tool.

Figure 26: Help Menu

4.3.6 Context Menus

Some of the functionality of nodes and edges is available via different context menus
that are selected by a right click on the node or on a green point of an edge.

Input Nodes and Output Nodes

• Connect output from selected node to this: This entry is used
to connect two nodes.

• Delete: Deletes the node

• Change External File Name: Selects another file for the node.

• Change External File Type: Changes the type of the file.

• Edit Comment: Edit the comment containing a description of this file.

Job Nodes

• Connect output from selected node to this: This entry is used
to connect two nodes.

• Delete: Deletes the node
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• Edit: Opens the attribute window of the job node. The attributes displayed in
those windows depend on the type of job node (see Sect. 4.4 for all job nodes
and their corresponding attributes).

• Change Name: Changes the name of the job node that is displayed in the
canvas.

• Show Commandline Call: Prints the commandline call of the job node
that is used when exporting the workflow to a shell script.

• Edit Comment: Edit the comment containing a description of this job.

Edges

• Delete Connection: Deletes the connection.

• Edit Connection: Opens the attribute window of the edge, where the file
name, file type and order key can be changed (see Sect. 4.2 for an explanation
of these attributes). Additionally one can specify which of the attributes should
be displayed on the canvas.

• Add EdgePoint: Adds an additional point to the edge that can be used to
specify the pathway of the edge.

• Delete EdgePoint: Deletes the edge point provided it is not the sole point
of that edge.

• Auto Position: If enabled the selected edge point will be positioned auto-
matically, otherwise it can be positioned manually within the grid.

• Plot Details: Opens the edge view plot window that can be used to plot
characteristics of the model that is propagated along the edge.

• Print Details: Opens the edge view print window that can be used to print
characteristics of the model that is propagated along the edge.

4.4 Supported Tools

ProFiDo currently supports several tools for fitting and analysing distributions and
stochastic processes that can be integrated into a workflow as job nodes (cf. Figs. 5
and 23). In the following these tools and their parameters will be introduced. Ad-
ditionally, the generated output and the expected inputs are listed to clarify which of
the job nodes may be connected. We will only briefly introduce the basic ideas of the
different algorithms, but omit the full theoretical background. For the interested reader
some references providing this background information will be given.

4.4.1 Distribution Fitting

ProFiDo currently supports three tools for distribution fitting. DistFIT is a general tool
for fitting various common distributions whereas GFit and Momfit specialise on fitting
PH distributions.
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DistFit DistFit provides parameter estimation for various common distributions
based on a given trace. For most distribution types the fitting is based on the MLE
(maximum likelihood estimator) [13] . A complete list of supported distributions, their
properties and the corresponding fitting approach can be found on the ProFiDo website
[5]. Fig. 27 shows the parameters of DistFit. Depending on the parameters entered

Figure 27: Property window of DistFit

the tool fits a single distribution or several distributions to the trace and determines the
one with the best likelihood value. The output of the tool is an XML file as specified
in the ProFiDo XML interchange format [6]. It contains the distribution with the
best likelihood value for the given trace as its first distribution tag. All other fitted
distributions (if any) are written as sub tags of a first level <info> tag sorted in order
of their likelihood value. Furthermore each <distribution> tag has an <info>
sub tag containing the likelihood value of the corresponding distribution for the given
trace. Note, that the information from the <info> tag is usually not used by other job
nodes.

• Input: Trace

• Output: Distribution

• Parameters:

– auto: Fit all supported distributions to the trace and select the one with
the best log-likelihood value.

– exponential: Fits an exponential distribution to the trace.

– normal: Fits a normal distribution to the trace.

– lognormal: Fits a lognormal distribution to the trace.

– johnson: Fits a Johnson distribution to the trace.

– uniform: Fits an uniform distribution to the trace.

– triangular: Fits a triangular distribution to the trace.

– erlang: Fits an Erlang distribution to the trace.

– gamma: Fits a gamma distribution to the trace.
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G-FIT G-FIT [26] implements an EM Algorithm to fit the parameters of hyper
Erlang distributions maximising the likelihood value. Hyper Erlang distributions are a
subclass of PH distributions with a special structure resulting in an efficient algorithm
that can be applied to large traces. G-FIT can operate in two modes: Either a single
hyper Erlang distribution with a given structure is fitted or the best distribution with a
given overall number of states is determined. The parameters of G-FIT are shown in
Fig. 28. G-FIT can either use the complete trace for fitting or work on an aggregated
trace as described in [21].

Figure 28: Property window of G-FIT

• Input: Trace

• Output: PH distribution, MAP

• Parameters:

– Single Erlang: Fits a single hyper Erlang distribution to the trace.
The parameter is specified as a list of numbers, where the first number de-
termines the number of Erlang branches and the following numbers define
the number of phases for each branch, e.g. 3 1 1 1 fits a hyper Erlang
distribution with 3 branches where each branch consists of 1 phase.

– All Erlang: Fits different settings of hyper Erlang distributions with
a given number of states and selects the distribution with the best likeli-
hood value. The parameter is specified as a list of 3 values, where the first
value determines the overall number of states, the second value the min-
imal number of Erlang branches and the third value the maximal number
of branches. Note, that only one of the parameters Single Erlang or
All Erlang may be enabled.
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– Conv. e: Determines the ε value for the convergence check. If the
values between two iterations of the EM algorithm improve less than ε the
optimisation stops.

– Conv. Check: Determines the type of convergence check. If checked,
the maximal difference between parameter values of the distribution is
used, otherwise the difference between log-likelihood values.

– Logarithmic Trace aggregation: If enabled this value specifies
the number of intervals that are used to aggregate the trace on a logarithmic
scale.

– Uniform Trace aggregation: If enabled this value specifies the
number of intervals that are used to aggregate the trace.

Momfit Momfit [9] fits the parameters of an acyclic PH distribution by applying a
non linear optimisation algorithm according to the moments of the trace. The optimi-
sation approach minimises the least squares difference between the weighted moments
of the trace and the fitted distribution and is independent of the length of the trace.
Fig. 29 shows the property window of Momfit.

Figure 29: Property window of Momfit

• Input: Trace

• Output: PH distribution, MAP

• Parameters:

– Moments: The number of empirical moments of the trace that should be
considered for fitting.
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– States: The order (i.e. the number of transient states) of the PH distri-
bution.

– The algorithms stops, if either the number of Iterations has been
reached, the difference between the results of two subsequent iterations
is smaller than Epsilon or Time has been reached.

– Seed: Seed of the random number generator that is used to determine the
initial random PH distribution.

4.4.2 Fitting of Stochastic Processes

ProFiDo currently supports two types of stochastic processes, namely MAPs and ARI-
MA/ARTA/CAPP models, and a variety of different fitting algorithms for these pro-
cesses:

MAP_EM MAP_EM [8] applies an EM approach to the whole trace. The approach
is time consuming so that it should not be applied to fit MAPs with a larger state
space to long traces. However, since EM algorithms have a monotonic convergence,
the algorithm can be used to improve the likelihood of a MAP that has been fitted by
some other more efficient approach. In case only a trace file is provided as input the
algorithm will start with a random MAP, if additionally an existing MAP is provided
as input, the algorithm will use this MAP as initial solution and improve its likelihood.
The tool specific properties are shown in Fig. 30.

Figure 30: Property window of MAP_EM

• Input: Trace, MAP (optional)

• Output: MAP

• Parameters:

31



– Conv. e and #Iteration are used to specify the stopping criterion
for the algorithm. If either the improvement of the algorithm is less than
ε or the specified number of iterations have been reached, the algorithm
stops.

– MAP Dims determines the order of the MAP, i.e. the number of states.
– Alpha is a factor used for the randomisation technique.
– Seed of the random number generator used to generate the random initial

MAP.

MAP_MOEA MAP_MOEA [20] combines an EM algorithm for PH distribution fit-
ting with a multi-objective evolutionary algorithm to fit a MAP. Its parameters are
shown in Fig. 31.

Figure 31: Property window of MAP_MOEA

• Input: Trace

• Output: MAP

• Parameters:

– Number of Generation determines how many generations the evo-
lutionary algorithm should use.
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– Alpha, Mu and Lambda are parameters for the evolutionary algorithm.
They determine the population size α, the number of parent individuals µ
and the number of offspring individuals λ.

– Epsilon: Stopping criterion for the EM part of the algorithm. If the
improvement of the algorithm is less than ε the EM algorithm will stop.

– #Iteration determines the number of iterations of the EM algorithm
in the first fitting step.

– Dimension determines the order of the MAP, i.e. the number of states.

– Alpha2 is a factor used for the randomisation technique.

– Seed of the random number generator used to generate the random initial
MAP.

– Autocorrelation determines the number of lag-k autocorrelations
that are used for MAP fitting.

JMomfit JMomfit [9] performs a least squares fitting of the weighted joint mo-
ments of the trace and the fitted MAP. It is started with a PH distribution that is ex-
panded into a MAP. Consequently, the node expects a trace and a PH distribution as
input. Since only linear least squares problems have to be solved and joint moments
are fitted, the approach is very efficient and the effort is independent of the length of
the trace. The parameter window is shown in Fig. 32.

Figure 32: Property window of JMomfit

• Input: Trace, PH distribution

• Output: MAP

• Parameters:

– Joint Moments: The number n of joint moments to be considered for
fitting. The algorithm will use the first n×n joint moments from the trace.

ACfit ACfit [14] takes a trace and a PH distribution as input and fits a MAP ac-
cording to the lag-k autocorrelations of the trace. This implies the use of a non linear
optimisation method so that the effort becomes slightly higher than that for joint mo-
ment fitting, but the effort is still independent of the trace length. Fig. 33 shows the
parameters of ACfit.
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Figure 33: Property window of ACfit

• Input: Trace, PH distribution

• Output: MAP

• Parameters:

– Autocorrelation: The number of empirical autocorrelations from the
trace that should be considered for fitting.

MEPfit From a set of moments and joint moments the algorithm constructs two
matrices H0 and H1 as described in [24, 27] and tries to transform them into a valid
MAP description (D0,D1) by searching for a non-singular matrix B such that D0 =
B−1H0B and D1 = B−1H1B. It should be noted, that the last step might fail, if
there is no MAP that exhibits the desired (joint) moments or if the method does not
find such a MAP. In this case the best matrices that have been found are returned,
which either describe a Matrix Exponential Process (MEP) or may not even describe a
stochastic process at all. Fig. 34 shows the parameters of MEPfit.

Figure 34: Property window of MEPfit

• Input: Trace

• Output: MAP

• Parameters:

– Order: The number of states of the MAP.
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ARIMA Fitting The free software R [23] contains a large number of statistical meth-
ods including methods to determine the parameters of ARIMA models, that are used in
ProFiDo to generate ARIMA processes from trace data. Fig. 35 shows the parameters
of the node ARIMA Fitting.

Figure 35: Property window of ARIMA Fitting

• Input: Trace

• Output: ARIMA process

• Parameters:

– AR Order, Degree of Differencing and MA Order specify the
order of the ARIMA process, i.e. the number of autoregressive coefficients
p, the degree of differencing d and the number of moving average coeffi-
cients q.

ARTAfit For a given distribution FY and empirical autocorrelation coefficients of a
trace this approach constructs an ARMA base process, such that the resulting ARTA
process with marginal distribution FY exhibits the desired autocorrelations from the
trace. For more details see [11]. Fig. 36 shows the parameters of the node ARTAfit.

• Input: Distribution, Trace

• Output: ARTA process

• Parameters:

– Autocorrelations: Determines the number of autocorrelation coef-
ficients that are considered for fitting.

– min. AR order, max. AR order, min. MA order, max.
MA order: Determines the order of the base process. ARTAfit will
fit base processes for all possible combinations given by the minimal and
maximal AR and MA order and select the base process with the best result.
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Figure 36: Property window of ARTAfit

CAPP-Fit For a given PH distribution FY and empirical autocorrelation coefficients
of a trace this approach constructs an ARMA base process, such that the resulting
Correlated Acyclic Phase-Type Process (CAPP) with marginal distribution FY exhibits
the desired autocorrelations from the trace. For more details see [15]. Fig. 37 shows
the parameters of the node CAPP-Fit.

Figure 37: Property window of CAPP-Fit

• Input: PH Distribution, Trace

• Output: CAPP

• Parameters:
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– Autocorrelations: Determines the number of autocorrelation coef-
ficients that are considered for fitting.

– min. AR order, max. AR order, min. MA order, max.
MA order: Determines the order of the base process. CAPP-Fit will
fit base processes for all possible combinations given by the minimal and
maximal AR and MA order and select the base process with the best result.

4.4.3 Trace Generation

Modgen This job node allows for the generation of a trace from a given model de-
scription. Only a single model description is allowed as input. The trace length can
be defined by setting parameter TraceLength. Fig. 38 shows the parameters of the
node Modgen.

Figure 38: Property window of Modgen

• Input: Distribution, PH distribution, MAP, CAPP, ARIMA or ARTA process

• Output: Trace

• Parameters:

– TraceLength determines the length of the generated trace.

4.4.4 Statistical Two Sample Tests

Dist_Tests Job node Dist_Tests applies statistical two sample tests offered by
the statistical software R [23] in this way validating the hypothesis that two samples
are from the same distribution. The result is a LATEX table giving the P-values of the
applied tests. At present, Kolmogorov-Smirnov and Pearson’s Chi-Squared tests are
supported.

Job node Dist_Tests needs no parameters specified by the user and exactly two
inputs, i.e. two input arcs, of type XML-Trace are needed for proper functioning.

• Input: Two Traces

• Output: Table in LATEX format

• Parameters: NONE
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4.4.5 Result Visualisation

Plot The Plot node helps to visualise model characteristics such as cumulative dis-
tribution functions and autocorrelation lags for given model descriptions or traces. Its
properties are shown in Fig. 39.

Figure 39: Property window of Plot

• Input: any number of Traces, distributions, PH distributions, MAPs, CAPPs,
ARIMA and ARTA processes

• Output: Image in PostScript, PDF or PNG format

• Parameters:

– Format: File format of the generated output image. Allowed values are
ps for PostScript, pdf for Portable Document Format or png for Portable
Network Graphics.

– Start and End determine the range on the x-axis that is plotted (cf. Fig. 14).

– Type: Type of plot. Possible values are ac for lag-k autocorrelation co-
efficients, cdf for the cumulative distribution function, pdf for the prob-
ability density function, mom for moments and jmom for joint moments.
For mom the moments E[Xi] for all i in the range from Start to End
are determined for all models and the values relative to the moments of the
first model are plotted. For jmom the joint moments E[Xi

0X
i
1] are used.

Print The Print node offers the possibility to generate LATEX tables containing
several characteristic figures of process descriptions. Currently supported are moments
and joint moments. Fig. 40 shows the tool specific properties.

• Input: any number of Traces, distributions, PH distributions, MAPs, CAPPs,
ARIMA and ARTA processes

• Output: Table in LATEX format (cf. Table 1)
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Figure 40: Property window of Print

• Parameters:

– Format: File format of the generated output. Currently only latex is
supported.

– Relative: If true the (joint) moments are computed relative to the values
of the first model (i.e. the model resulting from the job node that has been
connected first to the Print node). If false the absolute values are
printed.

– Start and End determine the first and last value to be computed.

– Type: Type of data to be printed. Possible values are ac for lag-k auto-
correlation coefficients, cdf for the cumulative distribution function, pdf
for the probability density function, mom for moments and jmom for joint
moments.

Queue The Queue node is an additional way to compare processes. This job node
simulates a single server queue with a trace or stochastic process as input and returns
a plot of the queue length distribution.2 The unit of measurement for the interarrival
times used as input for the queue are in seconds. Fig. 41 shows the tool specific prop-
erties. The Queue node expects the service time, the buffer size and the simulation
time as additional parameters. The job node uses OMNeT++ [12] as simulation engine
and therefore the service time must be specified in OMNeT++’s syntax (see below).

• Input: any number of Traces, MAPs, CAPPs, ARTA and ARIMA processes

• Output: Image in PostScript
2The value given for queue length i is the sum of all time intervals where i customers have been in

the queue divided by the overall simulation time. Note that the given queue length distribution might
vary for different simulation times because of transient behaviour. Note that no confidence intervals are
calculated. For further information on simulation see e.g. [13].
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Figure 41: Property window of Queue

• Parameters:

– Service-Time: The service time of the server. This value may be either
deterministic or drawn from a probability distribution. See sections 3.6, 8
and 20 from [19] for the available functions and probability distributions.
Note, that the expression must be enclosed in quotation marks and that
OMNeT++ expects a unit of measurement, e.g. "exponential(1.0s)"
draws the service time from an exponential distribution with a mean of 1
second.
Note that the interarrival times used as input for the queue are in seconds.

– Buffer: The maximum length of the queue.

– Sim. Time: The simulation time, including a unit of measurement, e.g.
“175000s”.
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A Developing ProFiDo

In the following we provide a brief overview of several approaches that can be used
to extend ProFiDo and introduce tools helping in that process. Sect. A.1 provides an
overview how additional command line tools can be integrated using the XML based
configuration file. In Sect. A.2 a small test suite consisting of some extensions to the
source code and several bash scripts are described.

A.1 Integrating additional tools

ProFiDo provides a flexible environment that can be easily adapted to incorporate ad-
ditional command line tools (cf. [1]). The GUI is able to handle any kind of command
line tool and exchange format between them and does not impose any limitation on the
software controlled by it.

The tools that can be managed with ProFiDo are specified in the software.xml
file. The general approach of adding new job and input nodes is described below.
For detailed information about the configuration format please refer to the provided
specification[2].

A.1.1 Job Nodes

The main building block of any ProFiDo workflow are the job nodes, where each job
node represents the execution of one command line tool. All tools controlled by the
GUI are required to accept at least one input file and to create at least one output file,
whose file names have to be definable by a command line parameter. By connecting
job nodes, the desired data propagation of results between the jobs is determined and
all file name management will be handled by ProFiDo.

When defining new jobs in the configuration file, the file types accepted and cre-
ated by the job and the corresponding parameter have to be specified. This allows the
GUI to ensure that only matching job nodes can be connected. In order to accomplish
a more homogeneous environment, it is recommended to specify an XML based ex-
change format between different job types as we have done in [6]. By defining an input
and output converter for each type of job, ProFiDo is able to manage the conversion
from data propagated within the workflow to the command line tools original accepted
and created file types and vice versa. By encapsulating the actual command line tools
in small hand written bash scripts, even tools that don’t allow the specification of file
names by command line parameters can be integrated in ProFiDo. An example of this
approach can be seen in the integration of G-FIT (cf. [1]).

A.1.2 Input and Output Nodes

As job nodes and their connections are used to represent the execution and data prop-
agation of command line tools, an explicit representation of external files that are en-
tered into and taken from the workflow is required. External files are represented by
input and output nodes. By defining converters for input and output nodes, ProFiDo
is able to manage the conversion from the external file types to the common exchange
format and vice versa.
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A.2 Test Manager

In order to detect potential errors, a test suite allowing automated tests of the ProFiDo
GUI has been developed. Its central approach is based on comparing exported work-
flow scripts of a modified ProFiDo version with corresponding reference exports, thus
detecting major errors and inconsistencies caused by any changes made.

It consists of two main parts which are described in the following.

A.2.1 TestManager class

The TestManager superclass within ProFiDo’s source code provides a standardised ar-
chitecture which allows the simulation of any desired user interaction. In combination
with ProFiDo’s ability to load a workflow from the location specified by its first com-
mand line parameter and export it to the location specified by its second parameter,
a series of tests can be automated by a bash script which is described in Sect. A.1.
Launching ProFiDo with the command line parameter -t <test mode> <user interac-
tions> enables the TestManager and specifies the desired number of user interactions.
By providing the additional command line parameter -d <n> a temporal delay between
the user interactions can be specified. Furthermore the software configuration file,
which is software.xml by default can be specified with the -c parameter.

Currently a subclass testing the main GUI by performing a series of random modi-
fications (deleting nodes and edges) to the workflow and undoing these changes after-
wards is provided. It is selected by passing workflowPanel as test mode.3 The nodes
and edges that will be deleted are selected randomly. By default, the random number
generator is using the time since midnight, January 1, 1970 UTC as its seed. In order
to reproduce errors that were encountered during previous tests it is possible to specify
the seed manually by using the -s parameter.

E.g., the call

java -jar profido.jar inputfile outputfile \
-c /tmp/mysoftware.xml \
-t workflowPanel 20 \
-d 10 -s 314159265

will start ProFiDo using /tmp/mysoftware.xml as configuration file and seed-
ing the random number generator with 314159265. Upon starting the GUI loads the
input file inputfile and 20 user interactions (removals of nodes and edges) will
be performed with a delay of 10ms between each action. After all user interactions
have been performed the current workflow will be exported as workflow script using
the passed output file outputfile as target location.

Whenever the TestManager is activated, a brief overview of the selected settings is
outputted on the command line. Furthermore the command line call that will execute
the exact same test again is printed out.

3If x is the number of user interactions min(x, number of nodes) node deletions and afterwards min(x,
number of edges) edge deletions are performed.
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A.2.2 Bash scripts perform_tests.sh and perform_diffs.sh

Using the above described capabilities of ProFiDo, the script perform_tests.sh
performs a series of tests on an executable jar version of ProFiDo. When executing the
script all workflows located at a specified location are loaded and several test rounds
are performed with every workflow, each consisting of loading, randomly modify-
ing and exporting the workflow using the workflowPanel mode of the TestManager
described above. The exported workflow scripts are named according to the loaded
workflow and are continuously numbered during the test rounds, allowing easy attri-
bution of input workflows to the corresponding export and test round. For a workflow
located at the specified location and named x.sh the exported workflow scripts will
be named x_1.sh, ..., x_m.sh, where m is the number of desired test rounds.4

In order to detect potential errors, the exported scripts are then compared to refer-
ence exports of the corresponding workflow. For each workflow located at the specified
workflow folder, a reference export with the same base name is expected to be located
at the specified reference location.5

The actual comparison is done by the script perform_diffs.sh, which out-
puts an overview containing a list of all exports that did not match the corresponding
reference file. In order to filter differences that will only result in a different order
of execution line-wise alphabetical sorted versions of the input files are compared
additionally. Furthermore lines only containing irrelevant information (e.g. infor-
mation on the ProFiDo version, user specified folders, etc.) are filtered using grep
before any other processing is done. For a more detailed documentation of script
perform_diffs.sh see the first lines of the script file.

Be aware that the provided scripts can be a substantial help in detecting errors, but
should never be relied on exclusively, as only certain types of errors can be detected
this way.

The perform_tests.sh script takes a series of parameters to specify the files
and folders on which it should operate and the desired amount of tests. The script is
called with the following options

perform_tests.sh <profido jar> <workflow folder> \
<reference folder> <target folder> \
<test count> <actions per test>

where

• <profido jar>
specifies the location of the JAR-File which is used for the tests.

• <workflow folder>
defines the location where the workflows used for the tests are located. Any
XML-file located in this folder will be used for the test.

• <reference folder>
specifies the location where the reference exports of the workflows are located.

4As ProFiDo creates a setup script for each exported workflow script, additional files named
x_1_setup.sh, ..., x_m_setup.sh will be created.

5Additionally to the reference workflow script a corresponding reference setup script is expected as
well for each workflow at the specified reference location.
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A reference export for each workflow in the <workflow folder> is expected to
be located here.

• <target folder>
defines the folder where the exported workflows and report files will be stored.

• <test count>
defines the number of test rounds that should be done on each workflow file.

• <actions per test>
specifies the amount of user interactions (amount of deleted nodes and edges as
described above) that should be done within one test round.

The perform_tests.sh script creates four detailed report files for each work-
flow found in the workflow folder, listing all differences between the workflows ref-
erence exports and the exports created during the test rounds. Additionally sorted
versions of the files are compared to each other as described above. Furthermore a
logfile is created within the target folder listing all command line calls executed by the
script in order to allow easy recreation of results when needed.

Assuming that a folder within the user’s home directory named ProFiDo/test with
two subfolders exists, one containing input workflows and one containing the corre-
sponding reference exports, a sample call performing 4 test rounds on each of the
workflows with 8 user interactions per test round would be of the following form:

./perform_tests.sh ~/ProFiDo/profido.jar \
~/ProFiDo/test/workflows \
~/ProFiDo/test/reference_exports \
~/ProFiDo/test 4 8
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Redo, 25
Show, 25
Undo, 25

Hyper Erlang distribution, 29
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Kolmogorov-Smirnov test, 37

LATEX table, 8, 38
latex, 39
LBL-TCP-3, 6
least squares, 30, 33
Likelihood, 28
Load Workflow, 23
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Portable Network Graphics, 38
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Print, 8
ProFiDo
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command line parameters, 42
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software, 4
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installation, 3
License, 3
profido.jar, 4
profido.sh, 4, 6
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software.xml, 4
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result directory, 22

Save Screenshot, 25
Save Workflow, 23
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Settings
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Settings Menu, 23, 25
Show History, 25

tag
info, 28

Tcl/Tk, 4
Test Manager, 42
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Workflow, 8

connecting nodes, 12
description, 6
edges, 10
execution, 12, 13, 17, 21, 23
export to shell script, 12
layout, 20
load, 23
new, 23
nodes, 8
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